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Legal information 
Use of application examples 

Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG ("Siemens"). They are 
non-binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 
Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 
By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  
The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with Industrial Security functions that support the secure 
operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 
Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the Internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.  
For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at: https://www.siemens.com/industrialsecurity. 
 

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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1 Introduction 
The SIMATIC ET 200SP HA offers a scalable, fault-tolerant distributed I/O system. 
The distributed I/O system combines high flexibility with scalability. 

The PROFINET communication standard is used for linking process signals to a 
superordinate controller, e.g. an S7-1500R/H.  

The ET 200SP HA is fully integrated by means of MDD (Meta Device Description) 
from TIA Portal version V16 onward. A GSDML file (Generic Station Description 
Markup Language) is available for integration into other tools. 

This application example describes the fault-tolerant hardware configuration of the 
SIMATIC ET 200SP HA and its components.  

The linking of the PROFINET interface module IM 155-6 PN HA in conjunction with 
various I/O modules is also described.  

In addition, the application example includes the cross-channel and channel-
specific signal configuration in TIA Portal using the example of the digital module.  

Finally, the hot-swap function (i.e. replacement of electrified modules during 
operation) and station expansion during operation in TIA Portal are also described. 

 

Figure 1-1 SIMATIC ET 200SP HA 

 

 

 

The SIMATIC ET 200SP HA supports the following PROFINET functionality when 

in conjunction with TIA Portal:  

• simple S1 system connection 

• simple S2 system redundancy and  

• Media Redundancy Protocol (MRP) 

This means that the SIMATIC ET 200SP HA can be linked both to standard as well 
as to fault-tolerant automation systems. Changes to the configuration during 
operation are supported if the corresponding prerequisites are met. 
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Mechanical design 

The SIMATIC ET 200SP HA is constructed in a modular manner. Thanks to the 
modular construction, it is possible to implement various hardware configurations 
with up to 56 I/O modules. The section below explains the components of the 
SIMATIC ET 200SP HA. 

 

Figure 1-2 SIMATIC ET 200SP HA 

I/O modules

Terminal blocks

Interface module

Bus adapter

Subrack module for IM

Server module

Expl-safe I/O modules

Exp. power module

Expl. terminal blocks

Subrack modules

 

Table 1-1 

Component Function 

Subrack module for 
interface module (IM) 

Attached to the left side of the mounting rail for mounting an 
interface module 

Interface module (IM) Attaches to the subrack module, processes I/O data and the 
PROFINET communication with the automation server 

Bus adapter Attaches to the interface module and provides ports for copper 
and fiber-optic cable with PROFINET 

Subrack module Affixed to the mounting rail for mounting a terminal block and 
I/O modules 

Terminal block Attaches to the subrack module and provides terminals for 
connecting field cables 

I/O module Attaches to the terminal block, collects sensor information 
from the field (inputs) and drives actuators (outputs) 

Exp. power module Power module for intrinsically safe power supply 

Exp. subrack module Affixed to the mounting rail for mounting an explosion-
protected terminal block and explosion-protected I/O modules 

Exp. terminal block Attaches to the exp. subrack module and provides terminals 
for connecting field cables 

Exp. I/O module Attaches to the exp. terminal block, collects sensor information 
from explosion-hazard areas (inputs) and drives actuators in 
explosion-hazard areas (outputs) 

Server module Attaches to the final, far-right subrack module and serves to 
protect against dust and electromagnetic interference. 

 

Note You can find detailed information on components, installation and commissioning 
of the ET 200SP HA in the system manual "Distributed I/O System 
ET 200SP HA": https://support.industry.siemens.com/cs/ww/en/view/109798410 

https://support.industry.siemens.com/cs/ww/en/view/109798410
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1.1 Content of the application example  

Using TIA Portal as an example, here you will learn how to integrate the SIMATIC 
ET 200SP HA into automation systems.  

The use of some functions of the SIMATIC ET 200SP HA will also be described, 
using TIA Portal as a basis. 

 

Figure 1-3 Hardware setup of the application example 

PROFINET

TIA Portal

Industrial Ethernet

ET 200SP HA

SCALANCE XC206 SFP

CPU S7-1513R

 

1.2 Components used 

The following hardware and software components were used to create this 
application example:  

 

Table 1-2 

Hardware component Quantity Item number Note 

SIMATIC Field PG 1  Or PC with TIA Portal 

ET 200SP HA,  

IM155-6 PN 

1 6DL1155-6AU00-0PM0 Interface module 

ET 200SP HA, BUS 
ADAPTER BA 2XRJ45 

1 6DL1193-6AR00-0AA0 Bus adapter 

Subrack module  1 6DL1193-6BH00-0SM0 Subrack module IM 
single, incl. server 
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Hardware component Quantity Item number Note 

interface module  module 

Subrack module 8x 1 6DL1193-6GC00-0NN0 Subrack module with 
space for up to 8 
modules 

Terminal block, TYPE P0 1 6DL1193-6TP00-0DP0 Terminal block for new 
potential group 

Terminal block, TYPE H1 4 6DL1193-6TP00-0BH1 Terminal block, use of an 
existing potential group 

DI 32X24VDC 1 6DL1131-6BL00-0PH1 I/O module digital inputs 

DI 16X24VDC 1 6DL1131-6BH00-0PH1 I/O module digital input 
module 

DQ 16X24VDC/0.5A 1 6DL1132-6BH00-0PH1 I/O module digital output 
module 

AI 16XI 2-WIRE HART 1 6DL1134-6TH00-0PH1 I/O module analog inputs 

AQ 8XI HART 1 6DL1135-6TF00-0PH1 I/O module analog 
outputs 

5 TB COVER, 22.5MM 1 6DL1133-6CV22-0AM0 Cover for 32X24VDC 
group on P0 terminal 
block 

BaseUnit W0  1 6DL1193-6BP00-0DW0 Terminal block for 
accepting the power 
module 

Power module Ex-PM E 1 6DL1133-6PX00-0HW0 Power module for 
intrinsically safe power 
supply 

BaseUnit X1 for I/O 
modules 

6 6DL1193-6BP00-0BX1 Terminal block for exp. 
I/O modules 

Digital ex-i input module 1 6DL1131-6TD00-0HX1 Ex-DI 4xNAMUR 

Digital Ex-i output 
module 

1 6DL1132-6EB00-0HX1 Ex-DQ 2x23.1VDC/20 
mA 

Digital Ex-i output 
module 

1 6DL1132-6CB00-0HX1 Ex-DQ 2x17.4VDC/27 
mA 

Analog Ex-i HART input 
module 

1 6DL1134-6TB00-0HX1 Ex-AI 2xI 2-wire HART 

Analog Ex-i input module 1 6DL1134-6JD00-0HX1 Ex-AI 4xTC/2xRTD 2-/3-
/4-wire 

Analog Ex-i HART output 
module 

1 6DL1135-6TB00-0HX1 Ex-AQ 2xI HART HF 

SITRANS TH300 1 7NG3212-0... Temperature transmitter 

 

Table 1-3  

Software component Item number Note 

SIMATIC STEP 7 
Professional V17 

6AV2102-0AA07-0AA7 Download or DVD 

SIMATIC PDM stand alone  

V9.2  
6ES7658-3HA78-0YH5 Download or DVD  
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2 Configuration in TIA Portal 
This chapter describes all configuration steps that must be performed to integrate 
the SIMATIC ET 200SP HA via PROFINET. 

In addition, the configuration of the I/O link and the signal configuration will be 
described using the example of the DI 16x24VDC/0.5A input module, as well as the 
steps that need to be performed when replacing a module or expanding a station. 

The following project engineering status is required for configuring the hardware: 

• a TIA Portal project has been created 

• the S7-1513R CPU is configured 

• a connection between AS and the programming device (PG) via the plant bus 
is pre-configured 

 

The application example uses the following network parameters. 

 

Figure 2-1 Network parameters in the application example 

PROFINET

CPU S7-1513R

TIA Portal

Industrial Ethernet

ET 200SP HA

PN device „et200spha“
192.168.0.21/2

SCALANCE XC206 SFP

PN device „scalance“
192.168.0.10/1

PN Controller 
192.16.0.32/0

 

 

2.1 Configuration of the SIMATIC ET 200SP HA 

The status signals and process values are received and actuators controlled via 
the SIMATIC ET 200SP HA I/O modules on the process level. The interface 
module forms the interface between the process level and the automation system 
and ensures smooth data transfer in either the single or redundant version. 

An S2 system redundancy is configured in the application example. The interface 
module of the SIMATIC ET 200SP HA is therefore connected with both S7-1513R 
controllers. 
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2.1.1 Connecting the SIMATIC ET 200SP HA 

PROFINET device detection can be used for initial commissioning of the SIMATIC 
ET 200SP HA. To do this, proceed as follows: 

1. Connect the SIMATIC ET 200SP HA with PROFINET. 

 

2. In TIA Portal, open the "Devices & network" view. 

3. Open the "Online" menu in TIA Portal.  

4. Under "Hardware detection", select "PROFINET devices from network". 

 

Figure 2-2 

 

5. Select your network interface. 

6. Start the search for PROFINET devices. 

7. Select the SIMATIC ET 200SP HA. 

8. Add the SIMATIC ET 200SP HA to your project. 
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Figure 2-3 

 

 

 

The SIMATIC ET 200SP HA is now detected and has been added to the "Devices 
& network" view as a new distributed I/O device along with all plugged-in I/O 
modules.  

 

Note A warning will appear here to the effect that the last inserted module was not 
correctly detected. This refers to the server module that is not configured with the 
SIMATIC ET 200SP HA. Thus, you can ignore this message. 

 

Figure 2-4 

 

 

9. Assign the SIMATIC ET 200SP HA to the PROFINET controller "PLC_1" (CPU 
S7-1513R). To do this, click on the interface of the SIMATIC ET 200SP HA, 
then click and drag a connection to the interface of the left-hand R controller 
"PLC_1".  
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Figure 2-5 

 

 

10. Repeat the assignment of the SIMATIC ET200SP HA to the redundant 
controller "PLC_2". 

 

The result is a configured S2 system redundancy between the S7-1513R 
PROFINET controllers and the SIMATIC ET 200SP HA PROFINET device. 

 

Figure 2-6 

 

11. Double-click on the SIMATIC ET 200SP HA to open the properties of the 
SIMATIC ET200SP HA in the Inspector window.  

12. Configure the PROFINET interface of the SIMATIC ET 200SP HA. Assign the 
IP address and the PROFINET device name. You can also configure media 
redundancy, update time, and response monitoring time here.  

 

Figure 2-7 

 

 

 



2 Configuration in TIA Portal 

 

Integration of ET 200SP HA in TIA Portal 
Entry ID: 109801209,    V1.0,    09/2021   12 
 

©
 S

ie
m

e
n

s
 A

G
 0

9
/2

0
2

1
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Note If you are using type N0 or P0 terminal blocks with a width of 45 mm, you must 
modify this terminal block "BaseUnit" in the Device view. 

Figure 2-8 

 

 

2.1.2 Signal configuration of the I/O modules 

The I/O modules of the ET 200SP HA support cross-channel configuration. 
Settings and configurations for all channels are performed in one step. Individual 
channels of a module can be excluded from the cross-channel configuration and 
assigned new parameters on their own. 

 

1. In the Device view of the SIMATIC ET 200SP HA, select the I/O module whose 
signals you wish to configure. The module parameter assignment will open in 
the Inspector window. 

2. Open the "Module parameters > Channel template" tab. 

3. Define your channel template. Deactivate, for example, all channels so that 
only the channels you wish to use are active. 
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Figure 2-9 

 

 

4. Select "Channel 0". 

5. Unlink the channel from the channel template by selecting "Manual" from the 
Parameter settings dropdown menu. 

6. Enable the channel.  

7. Enable diagnostics. 

 

Figure 2-10 

 

2.1.3 Configuring HART channels 

The SIMATIC ET 200SP HA supports the connection of HART devices. The I/O 
modules must be specially parameterized in order to use HART devices. This 
section describes how to parameterize channel 15 of the AI 16xl 2-wire HART 
module. 

1. In the Device view of the SIMATIC ET 200SP HA, select the analog input 
module. 

2. In the Inspector window, navigate via "Inputs 0 – 15 > Inputs" to Channel 15, 
which the SITRANS TH 300 HART device is connected to. 

3. Enable the channel by selecting "Manual" in the Parameter settings dropdown 
menu. 
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4. Enable diagnostics.  

5. Enable the HART function by selecting the corresponding Measuring range. 

 

Figure 2-11

 

Note The failure monitoring according to NE43 can be enabled from firmware V1.1 
onward, thereby replacing the parameterized wire break limit. 

 

6. Select the "HART tag settings" and select the corresponding primary, 
secondary, tertiary and quaternary tags ("variables") of the HART device. 

 

Figure 2-12 
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Note It is possible to map up to 8 HART tags to the process image. Detailed 
information on the HART tags can be found in the module manual in the chapter 
entitled "HART variables". 
https://support.industry.siemens.com/cs/de/en/view/109770922/118926478475 

 

2.1.4 Monitoring process values 

After the SIMATIC ET 200SP HA has been configured and the project has been 
downloaded, you can monitor the process values in TIA Portal with a watch table or 
record them with a trace.  

In the example shown, in each case a channel of the DI 16X24VDC digital input 
module is connected with a channel of the DQ 16X24VDC/0.5A digital output 
module. Additionally, a connection between two channels of the AI 16xl 2-wire 
HART and AQ 8xl HART analog modules has been made. 

 

Figure 2-13 

 

 

Figure 2-14 

 

 

2.2 Diagnostic options in TIA Portal 

Diagnostics in the Device view 

Pending errors are reported to the PROFINET controller via the integrated system 
diagnostics. The context menu of the module (1) is used to switch to the "Online & 
diagnostics" view (2). The precise cause of the error can be examined here in more 
detail.  

 

https://support.industry.siemens.com/cs/de/en/view/109770922/118926478475
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Figure 2-15 

 

 

Channel-level diagnostics make it possible to diagnose channels individually. In the 
case shown, a wire break in channel 0 was detected. Channel diagnostics are 
configured for each channel manually or with the channel template.  

 

Figure 2-16 

 

 

2.3 Hot-swapping: replacing I/O modules with applied 
voltage during operation 

The SIMATIC ET 200SP HA supports the replacement of I/O modules with applied 
voltage during operation. 

I/O modules with switched-on load and switched-on power supply may not be 
pulled during operation without first electrically disconnecting them. For this case, 
the following I/O modules of the ET 200SP HA can be electrically disconnected via 
a release button: 

• Input/Output module AI-DI 16/DQ16x24VDC HART HA  

• Digital output module DI 16x24VDC HA  

• Digital output module DQ 16x24VDC/0.5A  

• Digital output module RQ 4x120VDC-230VAC/5A CO HA  
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• Electrical disconnection via the release button prevents arcs that can damage the 
SIMATIC ET 200SP HA and the connected sensors and actuators.  

 

CAUTION Danger of arcs 

Use the release button to ensure electrical isolation. Pull out and plug in I/O 
modules with the release button only when the load is switched off. 

 

1. If you are using one of the above I/O modules, press the release button for 3 
seconds.  

2. After 3 seconds, the red diagnostic LED flashes and the yellow maintenance 
LED lights up solid.  

In the "Online & diagnostics" menu of the I/O module, you can view the 
Diagnostic status and the Standard diagnostics for yourself in the Diagnostic 
status tab. The message "Shut-off via pushbutton handling" appears in the 
Standard diagnostics window. You are notified that the module can be pulled 
out. 

 

Figure 2-17 

 

 

3. The I/O module is disconnected from the terminal block and you can replace 
the module.  

4. The new I/O module starts automatically after installation.  

 

Note I/O modules without a release button can be replaced during operation without 
any effect on the remaining I/Os.  

A change of I/O module only becomes effective when the new hardware 
configuration has been downloaded to the controller with "Download in stop 
mode". 
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2.4 Preparing a station expansion with explosion-
protected I/O modules while in operation 

The SIMATIC ET 200SP HA can be expanded to a maximum of 56 modules during 
operation. In addition to normal I/O modules, these can also be explosion-
protected modules.  

1. Remove the server module and pull off the power bus cover on the end of the 
station.  

2. Click the "BaseUnit" of the explosion-protected power module onto the profile 
rail and slide it to the last component of the station on the rear wall bus. Insert 
the explosion-protected power module into the "BaseUnit".  

 

Note The explosion-protected power module ensures the intrinsically safe power 
supply to the explosion-protected I/O modules. Further information on 
intrinsically safe I/O modules for areas with explosion hazards can be found at: 
https://support.industry.siemens.com/cs/de/en/view/109796307 

 

3. Insert the "BaseUnits" for the I/O modules onto the profile rail and connect 
them to the rear wall bus of the explosion-protected power module. 

4. Insert the explosion-protected I/O modules into the "BaseUnits".  

5. Cap the station again with the server module and the power bus cover on the 
end of the station.  

2.5 Configuring the explosion-protected I/O modules 

After expanding the station with explosion-protected I/O modules, the modules 
must be configured in TIA Portal and the new hardware configuration must be 
downloaded to the controller with "Stop" mode. To do this, proceed as follows: 

1. Open the Device view of the SIMATIC ET 200SP HA. 

2. Add the explosion-protected power module to the next free slot with drag & 
drop. 

 

Figure 2-18 

 

 

3. Drag and drop to add the explosion-protected I/O modules to the SIMATIC 
ET 200SP HA station. 

 

https://support.industry.siemens.com/cs/de/en/view/109796307
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Figure 2-19 

 

 

4. Configure the channels of the explosion-protected I/O modules. 

5. Load the new hardware configuration. 

Proceed as described in chapter 2.1.2, Signal configuration of the I/O modules for 
the configuration. 

When using HART field devices, the procedure is identical to chapter 2.1.3, 
Configuring HART channels. 
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2.6 Configuring media redundancy 

Media redundancy is a function that ensures network and system availability. 
Special media redundancy protocols ensure a loop-free network topology and the 
detection of communication interruptions. In the TIA Portal environment, the 
standardized protocol known as "Media Redundancy Protocol" (MRP) is used. 
MRP is a redundancy protocol for increasing network availability in ring topologies 
and ensures loop-free communication in PROFINET networks. 

 

Figure 2-20 

 

2.6.1 Configuring the SCALANCE XC206 

You can find the SCALANCE XC206 SFP in the hardware catalog under "Network 
components > IE switches > SCALANCE X-200 managed > SCALANCE XC206". 

1. Drag and drop the device "SCALANCE XC206" into the Network view and 
place it next to the S7-1513R CPU and the SIMATIC ET 200SP HA. 

 

Figure 2-21 
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2. Assign the SCALANCE XC206 to the PROFINET controller "PLC_1" (S7-
1513R CPU).  

 

Figure 2-22 

 

3. Repeat the assignment of the SCALANCE XC206 to the redundant controller 
"PLC_2". 

 

Figure 2-23 

 

4. Double-click the SCALANCE XC206 to open the Properties of the SCALANCE 
XC206 in the Inspector window.  

5. Configure the PROFINET interface of the SCALANCE XC206. Assign the IP 
address and the PROFINET device name. You can also configure media 
redundancy, update time, and response monitoring time here. 

 

Figure 2-24 
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2.6.2 Configuring the ring topology 

1. Open the Topology view under Devices & networks. 

 

Figure 2-25 

 

 

2. Connect Port 1 of PLC_1 with Port 1 of the SIMATIC ET 200SP HA. 

 

Figure 2-26 

 

 

3. Make the rest of the connections in accordance with the ring topology. 

 

Figure 2-27 

 

 

4. Assign the individual devices in the Inspector window a defined role as per the 
table below. 
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Table 2-1 

Module PROFINET 
mode 

MRP role Ring ports 

S7-1513R PLC_1 Controller MRP Manager Port 1 

Port 2 

S7-1513R PLC_2 Controller MRP Manager Port 1 

Port 2 

ET 200SP HA Device MRP Client Port 1 

Port 2 

SCALANCE XC206 Device MRP Client Port 1 

Port 2 

 

Figure 2-28 

 

 

The result is a configured MRP ring topology. 

 

Note Only close the ring after configuration. Otherwise, telegram loops may form and 
cause communication failures in the network. 
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3 Device parameterization with SIMATIC 
PDM 
 

SIMATIC PDM is an established universal, multi-vendor tool for configuration, 
parameter assignment, commissioning, diagnostics and maintenance of intelligent 
field devices (sensors and actuators) and field components (remote I/Os, 
multiplexers, maintenance devices, compact regulators). The library supplied with 
SIMATIC PDM, with more than 3500 device descriptions for devices from more 
than 200 manufacturers worldwide, is perhaps the most comprehensive library on 
the market. 

If you work with TIA Portal, parameterize the PROFIBUS PA field devices with 
SIMATIC PDM stand alone. 

 

Figure 3-1 Device parameterization with SIMATIC PDM 

 

 

Note The parameterization of the field devices is only possible with SIMATIC PDM.  

Further information about SIMATIC PDM can be found in the manual "SIMATIC 
Process Control System PCS 7 Help for SIMATIC PDM" at the following link: 
https://support.industry.siemens.com/cs/ww/en/view/109755005 

https://support.industry.siemens.com/cs/ww/en/view/109755005
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3.1 Creating a SIMATIC PDM stand alone project 

To create a new SIMATIC PDM stand alone project, proceed as follows:  

 

1. Open the application "SIMATIC PDM stand alone". 

2. Create a new project with the highlighted icon or with "File > New..." 

 

Figure 3-2 

 

 

3. Right-click on "networks" to open the context menu.  

4. Click on "Insert New Object > Communication network".  

 

Figure 3-3 

 

 

5. Click on the button "Assign Device Type..."  

6. Choose "PROFINET network".  

7. Confirm with "OK".  
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Figure 3-4 

 

 

8. Give the network a name, e.g. "PROFINET network et200spha" and confirm 
with "OK".  

 

Result: The PROFINET network has been added to the project. 

 

Figure 3-5 

 

 

3.2 Configuring the SIMATIC ET 200SP HA and the 
SITRANS TH300 

3.2.1 Integrating device descriptions 

The latest device descriptions (EDD) for the SIMATIC ET 200SP HA and the 
SITRANS TH300 can be found in library supplied with SIMATIC PDM.  

 

Note The library from SIMATIC PDM V9.2 and device library "SIMATIC PDM Device 
Library 1#2020" is also available for download at the following link: 
https://support.industry.siemens.com/cs/ww/en/view/109794361 

 

1. Start the SIMATIC PDM Device Integration Manager.  

2. Click the icon "Read device descriptions from source folder…" in the function 
bar and then select the folder with the device description in the selection 
window.  

The device descriptions in the library will be read. All selected device 
descriptions will be integrated. 

3. Select the SIMATIC ET 200SP HA and the SITRANS TH300. 

https://support.industry.siemens.com/cs/ww/en/view/109794361
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4. Click the "Integration" icon in the function bar.  

 

Figure 3-6 
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3.2.2 Adding the SIMATIC ET 200SP HA 

To add the SIMATIC ET200SP HA with SIMATIC PDM stand alone, proceed as 
follows:  

1. Right-click on the "PROFINET network CFU" network to open the context 
menu.  

2. Click "Insert New Object > Object".  

3. Enter the PROFINET device name ("Object name"). 

4. Enter the configured IP address. 

5. Click on the button "Assign Device Type..."  

6. Click on the button "Device Identification". 

 

When the SIMATIC ET 200SP HA can be reached from your PDM station, the 
device has been found with the device identification feature and can be added to 
the project. Alternatively, you can also search for the SIMATIC ET 200SP HA 
manually in the device tree and add it to the project. 

 

Figure 3-7 
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3.2.3 Adding SIMATIC ET 200SP HA I/O modules 

To add the SIMATIC ET200SP HA with SIMATIC PDM stand alone, proceed as 
follows:  

1. Right-click on the SIMATIC ET 200SP HA network "et200spha" to open the 
context menu.  

2. Click "Insert New Object > Object".  

3. Enter the "Object name" and the number of I/O modules ("Count") of this type. 

4. Click on the button "Assign Device Type..."  

5. In the tree structure, select the I/O module according to the hardware 
configuration (DI 32X24VDC) and confirm with "OK". 

 

Figure 3-8 

 

6. Enter the slot number of the I/O module.  

7. Confirm with "OK". 
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Figure 3-9 

 

8. Repeat steps 1-7 for the remaining I/O modules. 

 

3.2.4 Adding the SITRANS TH300 

To add a field device, connected to the SIMATIC ET 200SP HA, in SIMATIC PDM 
stand alone, proceed as follows: 

1. Right-click on the SIMATIC ET 200SP HA "et200spha" to open the context 
menu.  

2. Click "Insert New Object > Object".  

3. Assign an object name for the SITRANS TH300. 

4. Click the "Assign device type..." button.  

5. Select the SITRANS TH300 sensor under "Devices > HART > Sensors > 
Temperature > Siemens AG > SITRANS TH300".  

6. Confirm with "OK". 

 

Figure 3-10 
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3.2.5 Parameter assignment for the field devices 

Open the PDM parameter view of the field devices via the context menu. You can 
open this view either with the SIMATIC ET 200SP HA "et200spha" in the so-called 
Multiview (with all configured field devices) or via an individual field device in the 
so-called PDM Singleview.  

To open the PDM parameter view for the field devices, click on "Open Object" in 
the context menu of a component.  

You can now parameterize the field devices in the PDM parameter view. 

 

Figure 3-11 
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4 Appendix 

4.1 Service and support  

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio. 

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs, application examples and videos 
– all information is accessible with just a few mouse clicks:  

support.industry.siemens.com 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers  
– ranging from basic support to individual support contracts.  

Please send queries to Technical Support via Web form: 

support.industry.siemens.com/cs/my/src 

SITRAIN – Digital Industry Academy 

We support you with our globally available training courses for industry with 
practical experience, innovative learning methods and a concept that’s tailored to 
the customer’s specific needs. 

For more information on our offered trainings and courses, as well as their 
locations and dates, refer to our web page: 

siemens.com/sitrain  

Service offer 

Our range of services includes the following:  

• Plant data services 

• Spare parts services 

• Repair services 

• On-site and maintenance services 

• Retrofitting and modernization services 

• Service programs and contracts 

You can find detailed information on our range of services in the service catalog 
web page: 

support.industry.siemens.com/cs/sc 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The app is available for iOS and Android:  

support.industry.siemens.com/cs/ww/en/sc/2067 
 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/my/src
https://www.siemens.com/sitrain
https://support.industry.siemens.com/cs/sc
support.industry.siemens.com/cs/ww/en/sc/2067
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4.2 Industry Mall 

 

The Siemens Industry Mall is the platform on which the entire siemens Industry 
product portfolio is accessible. From the selection of products to the order and the 
delivery tracking, the Industry Mall enables the complete purchasing processing – 
directly and independently of time and location: 
mall.industry.siemens.com 

 

 

4.3 Links and literature  

Table 4-1 

No. Subject 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Link to the article page of the application example  

https://support.industry.siemens.com/cs/ww/en/view/109801209 

\3\ Download link for SIMATIC STEP 7 Professional V17 

https://support.industry.siemens.com/cs/ww/en/view/109784440 

\4\ SIMATIC ET 200SP HA distributed I/O system 
https://support.industry.siemens.com/cs/ww/en/view/109747953 

\5\ Intrinsically safe Periphery modules for hazardous area - ET 200SP HA Ex 

https://support.industry.siemens.com/cs/de/en/view/109796307 

 

4.4 Change documentation 

Table 4-2 

Version Date Change 

V1.0 09/2021  First edition 

   

 

https://mall.industry.siemens.com/
https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/109801209
https://support.industry.siemens.com/cs/ww/en/view/109784440
https://support.industry.siemens.com/cs/ww/en/view/109747953
https://support.industry.siemens.com/cs/de/en/view/109796307
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